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SMARTMASK V.11.0 | SAVE TIME ON COMPLEX SELECTIONS!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use.

There are many occasions when you need to target a specific area of an image. It is often necessary to
highlight regions to which an effect or correction should be applied. Creation of photo collages and
montages requires a precise selection of objects. This can be a painful task because many objects don't
have clearly defined edges and fade into the background. For instance, just try selecting yourself in a
group photo.

AKVIS SmartMask makes even a difficult selection incredibly simple! Now, you can spend less of your time
on selection of objects and more of it on creativity.

Extracting Complex Objects a Breeze!

The software provides powerful tools for masking objects on images and removing backgrounds. It can
create various selection types, with both soft and sharp edges. It even lets you select fluff, hair, fur, tree
branches, glass, or a transparent veil with just a few mouse clicks! The program also lets you get rid of the
unwanted color shades left on the cutout object by the environment.
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Outstanding Tools You'll Love

There are two modes of image processing: Auto mode, which offers a powerful algorithm for automatic
recognition of areas, and Manual mode, that includes a set of smart and helpful brushes to touch up the
results where needed.

The interface is so intuitive that you will feel like a child drawing in class: there are two pencils in Auto
mode - you draw a line with the blue pencil inside the object you want to select (for example, yourself on a
group photo), and then use the red pencil to create lines outside the object which define the areas that
should be cut out (the other people in the photo). The program then interprets your intentions and
intelligently makes the selection you want, understanding where the borders are.

With simple images, these pencils are often enough to produce professional-looking results. One more useful
tool is Quick Selection in Manual mode, a powerful feature that allows you select regions automatically with
just a few clicks.

In cases where the selected object stands against a background of a similar color range, or the object's
edges are uneven, you can use the touch-up brushes, like the Magic Brush and Background Eraser.

Also, it is possible to automatically remove the specified colors from an image using the cutting-edge
Chroma Key technology. The edges of the cut-out can be additionally adjusted using the Refine Edges
mode.

Afterwards, place the resulting selection on a new background - there's no limit for your creativity!
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Less Time on Selections, More on Creating!

Like all AKVIS products, SmartMask is not only a straightforward tool, but also fun to use. It makes the dull
process of image manipulation a fun and entertaining.

Making selections can take a great deal of time out of a designer's work day. For this reason, with AKVIS
SmartMask you can considerably increase your productivity! You will be freed from boring work and will
have more room for creativity and realization of your ideas.
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Saving your Work

When using the software, you can save a working draft of your project into an .akvis file which contains
the original image, the state of the image at the moment it was saved with all its parameters and settings,
and, in the Deluxe/Business versions, any manually created checkpoints which where added during your
work. This very helpful feature is highly appreciated by professionals.

 

AKVIS SmartMask is available as a standalone program and as a plugin to a photo editor. The plugin
version is compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, and other image editors.

The functionality of the product depends on the license type. Some features are only available for the
Home Deluxe and Business licenses. Compare the licenses and features.

During the trial period you can try all options and choose the license you like.
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INSTALLATION

Follow the instructions to install AKVIS SmartMask in Windows.

Start the setup exe file.
Select your language and press the OK button to launch the installation process.
To continue the installation process you have to read and accept the License Agreement.

Activate the check box "I accept the terms in the license agreement", and press Next.

To install the Plugin you should select your photo editor(s) from the list.
Hint: 
If your photo editor is not in the list, activate the component  Custom Plugins Directory

and choose the folder where you keep all plugins and filters, for example, C:\My Plugins. In
this case you should set this folder as the plugins folder in the settings of your photo editor.

Or you can copy the 8bf file into the Plug-ins folder of your image editor.

To install the Standalone version, make sure that the check-box Standalone is activated. 
To create a shortcut for the program on desktop, activate the component Shortcut on Desktop.

Press the button Next.
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Press the button Install.

The installation is in progress.
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The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

Press Finish to exit Setup.

After installation of the standalone version of SmartMask, you will see a new line in the Start menu:
AKVIS - SmartMask and a shortcut on desktop, if during installation the component Shortcut on Desktop
was enabled.
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After installation of the SmartMask plugin you will see a new item in the Filter/Effects menu of your photo
editor. For example in Photoshop: Filter -> AKVIS –> SmartMask. Please use this command to launch the
plugin in the editor.
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INSTALLATION

Follow the instructions to install AKVIS SmartMask in a Mac computer:

Open the virtual disk dmg:

- akvis-smartmask-app.dmg to install the Standalone version

- akvis-smartmask-plugin.dmg to install the Plugin to your image editor (Photoshop or Photoshop
Elements).

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS SmartMask application or AKVIS SmartMask PlugIn inside.

To install the Standalone version just drag the AKVIS SmartMask application into the folder
Applications (or any other place you like).

AKVIS SmartMask
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To install the Plugin drag the entire AKVIS SmartMask PlugIn folder into the Plug-Ins folder of
your graphic editor.

For example:

if you use Photoshop CC 2019, copy the plugin into Applications/Adobe Photoshop CC
2019/Plug-Ins;

if you use Photoshop CC 2018, copy the plugin into Applications/Adobe Photoshop CC
2018/Plug-Ins;

if you use Photoshop CC 2017, copy it into Applications/Adobe Photoshop CC 2017/Plug-
Ins;

if you use Photoshop CC 2015.5, copy it into Library/Application Support/Adobe/Plug-
Ins/CC;

if you use Photoshop CC 2015, copy it into Applications/Adobe Photoshop CC 2015/Plug-
ins;

if you use Photoshop CS6, copy it into Applications/Adobe Photoshop CS6/Plug-ins.

After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop
select in menu: Filter -> AKVIS -> SmartMask.

Run the standalone app by double-clicking on its icon in Finder.
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HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS SmartMask and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about
the version and the number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control

Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during
the evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered
functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will
affect which features will be available in the program. Consult the comparison table for more details about
license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.
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Click on ACTIVATE to start the activation process.

Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be
created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer
connected to  Internet ,  for  example,  w i th  a  USB st i ck .  Send us  th is  in format ion to:
activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (SmartMask.lic) using this information and will send it to your e-
mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the
AKVIS folder in Users’ Shared (Public) Documents:

Windows Vista/7/8/10:

Users\Public\Documents\AKVIS;

AKVIS SmartMask

14

mailto:activate@akvis.com


Mac:

Users/Shared/AKVIS.

Your registration is completed!

 

When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for
example, change Home to Home Deluxe or Business).
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SMARTMASK V.11.0 | SAVE TIME ON COMPLEX SELECTIONS!

AKVIS SmartMask makes even a difficult selection as easy as pie. 
Now, you can spend less of your time on selection of objects and more of it on creativity.

The functionality depends on the license type. During the test period you can try all options and choose
the license you like.

 

License Comparison:
Home 
(Plugin) 

Home 
(Standalone)

Home Deluxe 
 (Plugin+Standalone) 

Business 
 (Plugin+Standalone)

Purpose

 non-commercial use

 commercial use

Edition

 Plugin 

 Standalone 

Features

 Automatic Selection Tools

 Manual Selection Tools

 Chroma Key

 Refine Edges

 Custom Background

 Post-Processing Tools

 History Palette

 Save and Load Projects

 Share

 Print

 Large Format Print

 EXIF, IPTC

Color Space

 RGB

 CMYK

 Lab

 Grayscale

 8 / 16 bits

 32 bits

Image Format

AKVIS SmartMask
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 AKVIS

 TIFF

 JPEG

 BMP

 PNG

 RAW

 DNG

 PSD

OS

 
Windows 7, 8, 8.1, 10 - 32-bit, 64-
bit

 
Mac OS X 10.11, macOS 10.12-
10.14 - 64-bit

10-days trial

Price $ 69 $ 69 $ 90 $ 120

 

 

AKVIS SmartMask

17

http://akvis.com/en/raw-format.php?ref=help
http://akvis.com/en/smartmask/price-selection-tool.php?ref=help#order
http://akvis.com/en/smartmask/price-selection-tool.php?ref=help#order
http://akvis.com/en/smartmask/price-selection-tool.php?ref=help#order
http://akvis.com/en/smartmask/price-selection-tool.php?ref=help#order


WORKSPACE

AKVIS SmartMask can be used as a standalone program or as a Photoshop compatible plugin.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

Attention! Before you call the plugin you must copy the image to a separate layer. Or just
unlock the layer.

 

The workspace will be arranged according to the chosen mode: Auto or Manual.

The Auto mode contains the tools that let you create a selection automatically. This mode is ideal for
images with a good contrast level and for objects with sharp edges. It can also be used as an initial stage
when working with complex objects.

Workspace of AKVIS SmartMask (Auto Mode)

The Manual mode contains the set of the smart brushes. These tools are helpful either if you need to
quickly select a simple object with a uniform color, or when selecting complex objects: glass articles, trees,
dishware, soap bubbles... You can also use these brushes to improve the result achieved with the
automatic tools.

AKVIS SmartMask
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Workspace of AKVIS SmartMask (Manual Mode)

 

Most of the program's workspace is taken up by the Image Window with two tabs - Original and
Processing. All operations are performed in the Processing tab. You can choose how these tabs will be
shown by adjusting the Image View Modes.

 

In the upper part of the program's window you can see the Control Panel:

The button  opens the home page of AKVIS SmartMask.

The button  (only in the standalone version) opens the image which will be edited. A right mouse

click on this button displays the list of recent files. You can change the number of recent documents
in the program’s Preferences.

The button  (only in the standalone version) saves the edited image to a file.

The button  (only in the standalone version) prints the image.

The button  lets posting pictures from the program to the social networks.

The button  lets you save a project into a file with the .akvis extension.

The button  lets you load the saved project (the .akvis file).

The button /  (only in Auto mode) turns on/off drawn strokes.

The button  cancels the last operation made with the tools. It is possible to cancel several

operations in a row.
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The button  returns the last cancelled operation. It is possible to return several operations in a

row.

The button  (only in Auto Mode) starts image processing.

The button  (only in plug-in) applies the result, closes the plugin’s window and the selected

object appears in the workspace of your photo editor.

The button  calls information about the program and opens the registration window.

The button  calls the Help files.

The button  calls the Preferences dialog box for changing the program’s options.

The button  opens the How-To panel with links to video tutorials and instructions.

The button  opens a window showing the latest news about SmartMask.

 

Also, in the Control Panel, you can find three modes:

The Chroma Key mode  (only for Deluxe and Business licenses) lets you quickly remove a

monochromatic background.

The Refine Edges mode  (only for Deluxe and Business licenses) lets you quickly adjust edges of

selections or cut-out objects.

The Custom Background mode  lets you insert a cut-out fragment into a custom background.

 

At the left side of the Image Window there is the Toolbar. Different tools will appear, depending on the
workspace mode (Auto/Manual) chosen. The tool’s parameters are shown in the Settings Panel or in a
pop-up box after right-clicking in the image window.

You can set up keyboard shortcuts ("hot keys") for all tools and actions.

 

At the bottom part of the left panel you can switch between the Mask View Modes:

 

Below you can adjust the Image View Mode.

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the
image which is visible in the main window; the area outside of the frame will be shaded. The frame can be
dragged, thereby changing the visible portion of the image. To move the frame, place the cursor within it,
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left click the mouse, and then drag.

You can hide/show the Navigator by clicking on its title.

In addition, you can move the image in the Image Window using the scroll bar or by holding down the
space bar, and then holding down the left mouse button while moving the mouse. The mouse’s scroll wheel
can move the image up and down, while holding Ctrl  on Windows, ⌘  on Mac – while moving the scroll
wheel will move the image left and right. Holding Alt  on Windows, Option  on Mac will scale the image.

Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons  and , to scale the image. When you click on the  button or move the

slider to the right, the image scale increases. When you click on the  button or move the slider to the

left, the image scale reduces. You can change the image scale by entering a new coefficient into the scale
field. The fall-down menu shows some frequently used coefficients.

You can also use hotkeys to zoom in and zoom out.

 

Under the Navigator there is the Settings Panel with the parameters of the chosen mode and the tool’s
options. The Default button recovers the default settings of the parameters.

Below you’ll find the History palette (which is only available for the Deluxe and Business licenses), that
shows the list of every change made to a file. By clicking on an item in the list, you can revert the file to a
previous state.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them

with the cursor. In Preferences  you can choose where the hints will be shown or hide this field.
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IMAGE VIEW MODES: ORIGINAL AND PROCESSING

At the bottom of the Toolbar of AKVIS SmartMask, there are three buttons which let you choose how the
Image Window will look like and arrange the Original and Processing tabs.

Click the first button to open a submenu that contains various options for viewing the original and
processed images:

- The button  provides the standard image window mode with two tabs: Original and

Processing.

- The buttons  and  divide the main window into two parts, vertically or horizontally,

respectively. The original and processed images become partially visible and the tabs are
combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the
Original and Processing parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as

well. However, in contrast to the previous option, the windows display the same fragment of
the image before and after processing.
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Note: Use two windows side by side when you want to see and compare the original and processed
versions of an image fragment on one screen. If you would rather see the final image as a whole, you
can choose the standard image view mode.

The button  swaps the positions of the original image and result when displaying two windows.

The 3rd button lets you choose the background color of the Image Window. Pressing , , or

 changes the background color to white, gray, or black, while clicking on  opens the Select

Color dialog where you can choose a color of your choice.
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HOW TO USE THE PROGRAM

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. The software can be
used as a standalone program as well as a plugin to a photo editor.

Follow these instructions to cut out an object using AKVIS SmartMask:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File To Open appears if you double-click on the empty workspace of the

program or if you click on the button  on the Control Panel. You can also drag the

required image into the workspace of the program.

The Standalone edition of AKVIS SmartMask supports BMP, JPEG, PNG, TIFF, RAW, and
AKVIS file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key
combination Ctrl+O .

Call the AKVIS SmartMask plugin. To this effect, select the menu item Filter:

in AliveColors: Effects -> AKVIS -> SmartMask; 
in Adobe Photoshop: Filter –> AKVIS –> SmartMask; 
in Corel Paint Shop Pro: Effects –> Plugins -> AKVIS –> SmartMask; 
in Corel Photo-Paint: Effects –> AKVIS –> SmartMask.

Attention! Before you call the plugin you must copy the image to a separate layer. Or just
unlock the layer.

Step 2. The first time the program is opened it will be in the Auto mode. It contains tools that let
you create a selection automatically. This mode is ideal for images with a good contrast level and for
objects with sharp edges. It can also be used as an initial stage when working with complex objects.

AKVIS SmartMask

24



AKVIS SmartMask Workspace, Auto Mode

When you switch to the Manual mode in the Control Panel, the interface’s appearance will change,
granting access to the smart brush tools. These tools are helpful if you need to quickly select a
simple object with an uniform color, or when selecting complex objects: glass articles, trees,
dishware, soap bubbles... You can also use these tools to improve the result achieved in the Auto
mode.
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AKVIS SmartMask Workspace, Manual Mode

Make a selection in any mode - Auto or Manual, or using both sequentially.

Note: If you switch to Auto mode, adjust the parameters or redraw lines, and run the image
processing again, the result of using the smart brushes will be lost. Please use the modes
sequentially: first Auto, then Manual.

Step 3. To remove a monochromatic background, use the Chroma Key mode (only for Home Deluxe
and Business licenses).
Step 4. Using the Refine Edges mode (only for Home Deluxe and Business licenses) you can quickly
adjust edges of selections or cutout objects.
Step 5. To add the cut-out object to a custom background, activate the Custom Background mode
(available only in the standalone version).

Step 6. You can save your project into an .akvis file by clicking on . Load it with . 

The AKVIS file contains the original image, the image in the current state, the tools’ parameters, the
color groups, and the checkpoints (Deluxe/Business) if they were created.

Step 7. You can share your image by clicking on . It opens the list of the services where you

can publish the image.

In the standalone version, you can also print your picture with .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the

format (TIFF, BMP, JPEG, PNG, or AKVIS) and indicate the target folder.

Note: If you activate the Color Background option in the Mask View Modes please keep in
mind that the result will be saved on the selected color background, just as you see it in the
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26



Image Window.

To save the selected object on a transparent background please choose the corresponding
mask view option and use the PNG format when saving the image (or other formats that
support transparency).

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS SmartMask

plugin will close and the fragment will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file,
choose the format and indicate the target folder.

 

Result
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MASK VIEW MODES

In the SmartMask's Toolbar you can switch between the Mask View Modes to display the cut out object
on different backgrounds.

Click on the button to open a submenu containing various options:

Transparent Background : 

This view mode shows the result on a transparent background.

 

Color Background : 

This view mode shows the cut-out object on a color background. By default the background is
orange, but you can change the color any time. For this purpose, click on the color plate  that

appears when you hover with the mouse over the button, and select a color from the dialog box.
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Custom Background :

The cut-out fragment will be placed on a new background. You can adjust the background image by
using the Custom Background mode.

Note: The result will be saved or printed on the selected background, just as you see it in the
window!

To save the selected object on a transparent background please choose the Transparent
Background option and use the PNG format when saving the image.

 

Grayscale Mask : 

This view mode shows all pixels with Transparency of 100% as black points. White points are the
pixels with Transparency of 0%. The pixels having Transparency between 0% and 100% are shown as
shades of gray. The darker the gray shade, the higher the transparency of this point.
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Find Unselected Areas : 

This view mode uses a trimap method - it separates the image for three regions:

All pixels with Transparency = 100% are shown as black points, the pixels with Transparency = 0%
are shown as white, and the gray points are all other pixels (0% < Opacity < 100%). 
This mode is good for finding areas that seem to be deleted, but they are not.
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CUSTOM BACKGROUND

The Custom Background mode  (available only in the standalone version) allows you to place a new

background image behind the cut-out object.

 

The Load button is used to load a new background image.

The Delete button removes the background image.

 

Adjust the uploaded background image using the parameters in the Settings Panel:

Opacity (50-100). This auxiliary parameter allows you to place the fragment more accurately by adjusting
its transparency. It does not affect the final result.

The Transform tab contains settings to adjust the size and position of the background image and the cut-
out fragment.

Edit Fragment. Enable the check-box to move and transform the cut-out object.
Size. You can resize the background image using the W and H fields. Also, you can increase or
decrease the size of the background by dragging one of the eight square markers on the image
frame. Couple the link  to maintain the aspect ratio. If the link icon is in the open state , the width

and height will be scaled independently of each other.
Rotation Angle. Set the rotation angle of the background image using the A field. Also, you can
rotate the image by moving your mouse in the Image Window. Outside the bounding frame the cursor
turns to a rounded two-sided arrow . Holding down the left mouse button, rotate the image

clockwise or counter-clockwise. If you press Alt , the rotation angle will change in five degrees.

Click on  to rotate the background image by 90 degrees counterclockwise.

Fit to Original . The background will be scaled to completely fit the original image.

Fill . The background will be scaled to cover the entire original image.

 
New Background

AKVIS SmartMask

31



Flip horizontally . This option allows the background to be mirrored along the standing axis,

i.e. interchanging the left and right sides.

Flip vertically . This option mirrors the background by turning it upside down.

 

Use the Correction tab to make adjustments to the tonal range of the background image.

Brightness (-100..100). The parameter changes the brightness of the background image. At higher
values, the background image becomes lighter. At lower values, the image becomes darker.

Contrast (-100..100). The parameter increases (at values greater than 0) or decreases (at values
less than 0) the difference between light and dark areas of the background image.

Saturation (-100..100). The parameter defines the color intensity of the background image.

 

Brightness = -50

 

Brightness = 50

 

Contrast = -50

 

Contrast = 50

 

Saturation = -50

 

Saturation = 50
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Blur (0-100). This parameter reduces the sharpness of the background image.

Click OK to confirm the changes. Press Cancel to exit the mode without saving the changes. Press the
Default button to restore the image to its original state.

 

 

Blur = 5

 

Blur = 50
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HISTORY PALETTE

The History palette is available in Home Deluxe and Business versions only. See the feature comparison
chart here.

Hint: Users with any licenses (Home/Home Deluxe/Business) can use the Undo/Redo /

commands and the History Brush tool .

The History palette shows the list of every change made to a file. By clicking on an item in the list, you
can revert the file to a previous state.

You can hide/show this panel by clicking on its title.

At the top of the palette, near a thumbnail of the image, there is information about the file: its name, size
(in pixels), color mode, profile, and date and time of creation.

The history of changes is arranged in a linear fashion. This means that if you return to any intermediate
state and apply an action, all actions on the list after it will be permanently removed, except for the
control points (which will be placed at the top of the list). Selecting Open from the list returns the file to
its initial state, as it was when loading to the program (before changes were applied).

History of Changes

All changes made are shown with their corresponding icon. Any successive changes made by the same tool
(two or more) are arranged in a group; the number of elements in a group is shown by a grey number to
the right of the icon. The list of elements in a group can be collapsed and reopened by pressing the "+" to
the left of the tool’s icon.

The following buttons are at the bottom of the History palette:

The button Undo/Redo Position State  and  switches between two states in the list. In

contrast to the buttons  and  that allow moving one step back/forward in a row, this button

allows restoring the history after the last change. Use this button if you want to restore the history
after the commands Delete States  or Collapse Group .

Individual states on a list can be preserved using checkpoints, with the Create Checkpoint 

button. Each control point that is added is given a name in succession (Checkpoint 1, Checkpoint 2,
etc). The checkpoint no longer has the history of that element but retains the change made to it.

To rename a checkpoint, double left-click on the checkpoint’s name, enter a new name and press
Enter .

You can save the checkpoints with the current state of the image to a file with the .akvis extension.

By pressing the button Delete States  all states below the selected one will be removed and all

checkpoints will be brought to the top of the list. If this button is pressed while a checkpoint is
selected, the checkpoint will be deleted.
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The Collapse Group button  collapses the list in a group and combines it into one state, removing

the individual history of each element. After this button is pressed individual elements in a group
cannot be edited.
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WORKING WITH PROJECTS

In AKVIS SmartMask you can save a working draft of your project into a file with the .akvis extension.
This file contains the original image, the state of the image at the moment it was saved, and manually
created checkpoints added during your work. It will also contain the most recently used color sets and
parameters.

How to work with a project in AKVIS SmartMask:

Step 1. Use the program’s tools and periodically save the result of your work with checkpoints by
pressing the Create Checkpoint  button in the History palette.

These control points (snapshots) lets you preserve the current state of the image with color strokes
and selections.

Note: The History panel is only available under the Home Deluxe and Business licenses,
therefore only users with these licenses can create checkpoints.

With Home licenses you can save the project to the AKVIS file with the state at the moment
of saving, with all parameters and settings, and with the original image, but without the
checkpoints.

Step 2. Save the result into a file with the .akvis extension.

To do this press , then choose a name for the file and press Save.
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Alternatively, in the standalone version you can save the project by pressing . Just choose the

AKVIS format.

Step 3. Open the saved project (*.akvis) by pressing . This file can also be opened by pressing 

 (only in the standalone version).

The History palette shows the saved checkpoints and the result. The original image is shown in the
Original tab and the Processing tab shows the last saved state.

You can switch between checkpoints in the History palette by clicking on the desired checkpoint
with the left mouse button. The corresponding image will be shown in the Processing tab.

Users of the Home version can only see the original file and the result, in the Original and
Processing tabs, respectively.
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You can work on a project in the AKVIS SmartMask plugin in the same way as in the standalone edition.
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PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program
workspace will automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light, Gray, or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the Image Window
after opening. The parameter can take one of two values:

- image scaling Fit to View. The scale adjusts so that the image will be completely visible in
the Image Window;
- if the option 100% is checked, image doesn’t scale. Generally, when the scale = 100%, only
part of the image will be visible.

Hints Panel. When you hover over parameters and buttons with the cursor you can see a brief
description of them in the Hints field. You can choose how the hints will be shown:

- Under Settings Panel. Select this to show hints at the bottom of the right part, under the
settings;
- Under Image Window. It shows the hints in the main window, under the image. This mode is
useful if there is not enough space by height to display this field under the settings;
- Hide. Use this option if you do not need the hints.

Recent Files (available only in the standalone version). The number of recent documents. The list of

the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Use OS File Dialog check-box. You can check this option if you want to use the System Open/Save
Dialog. By default, the AKVIS File Dialog is used.
Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the
check-box is enabled the panel is always visible. Uncheck the option to unlock the panel, and you will
be able to hide/show it by clicking on the small triangle button (in the middle of the panel). The
minimized panel will be shown when moving the cursor over it.
Hot Keys. Click on the button to open the dialog box where you can set up keyboard shortcuts for
all tools and actions.
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To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.

 

HOTKEYS (KEYBOARD SHORTCUTS)
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HOTKEYS (KEYBOARD SHORTCUTS)

Some operations are easier and faster to do using the so-called "hot keys" on the keyboard.

To activate a tool you can click on the corresponding icon with the mouse or you can use key combinations
on the keyboard. The latter method can substantially increase your productivity.

In AKVIS SmartMask you can see the list of all available shortcuts, and edit them.

How to customize your hot keys:

Click on  to open the Preferences dialog box.

Press on the Hot Keys button.

This opens the Hot Keys dialog box with the list of all shortcuts.

Select the item (command, tool) whose shortcut you want to change. Double click on a cell to make
it editable.

You can use up to 4 combinations for each command/tool.

 

Keyboard shortcut list (default hotkeys) in AKVIS SmartMask:
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To save changes press OK.

To restore the default shortcuts click on Default.
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PRINT IMAGES IN AKVIS SMARTMASK

In the standalone version of AKVIS SmartMask you can print the image. 

Press the button  to open the Print options.

Print Options in AKVIS SmartMask

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number
of copies to print.

In the Orientation group, set the posit ion of paper: Portrait (vertically) or Landscape
(horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation,
as well as the print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to
Page. These parameters have no effect on the image itself, just on the print version. You can
change the size of the printed image by entering any value in %, or by entering new values in Width
and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for
the copies of the image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the
subsequent junction into a large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in
which the image will be divided. The image scale will be adjusted to fit this number of the
sheets. If the check-box is disabled, the program will automatically select the optimal number
of the pages in accordance with the actual size of the image (scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for
bonding sheets. Margins will be added to the right and to the bottom of each part.
Lines of Cut. Activate the check-box to display the cut marks in the margins.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column
and a row, will be printed in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.
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Click the Properties... button to open a system dialog box that enables you to access the advanced
settings and send the document to print.
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AUTOMATIC SELECTION TOOLS

The Auto mode is ideal for images with a good contrast level and for objects with sharp edges. It can also
be used as an initial stage when working with complex objects. It contains the tools that lets you create a
selection automatically.

 

Original Image

Step 1. Use the following tools to define the areas that must be deleted and the areas that must be
kept:

Keep Area Pencil . Use the blue pencil to draw an outline within the areas that should be

kept.

Drop Area Pencil . Use the red pencil to draw an outline within the parts that should be

deleted.

Eraser . Use the tool to erase drawn strokes.

The Eraser tool works in 4 modes: all lines, only red lines, only green lines, only blue
lines. Depending on the selected option, the tool erases only lines of the specified color.

 

Red and blue strokes
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Step 2. Start processing the image by clicking on . The image will be processed with the default

settings.

 

Result on a transparent background

Step 3. You can also use the Transition Area Pencil  to draw over the difficult areas. This tool

is useful when selecting hair, fluff, fur, branches of the tree, etc.

Define "transition areas" that contain both the parts that should be kept and the background that
should be deleted. The points in these zones have different Transparency values (between 0 and
100%).

 

Using the green pencil

The Size of the tools can be adjusted in the Settings Panel or in a pop-up box after right-clicking in
the image window.
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Step 4. If you are not satisfied with the result, you can redraw the strokes:

 

Redraw strokes

…and adjust the algorithm’s parameters in the Settings Panel:

Edge Priority. This parameter defines the way the points between the red and blue outlines
are treated (undefined areas) and, thus, specifies the edges of the cut-out object. If you
increase the value of this parameter, the edges of the cut-out object are defined as the border
between the objects marked with different colors. If you reduce the value, the program will
give priority to the color range of the undefined areas. By default the value is set to 50 and the
program considers both principles equally.

Find Similar Areas. By default the check-box is disabled. In this case the points of the image
are colored in accordance with the strokes drawn in the nearby areas. When the check-box is
enabled, the program will compare the color of the undefined points with the color range of the
points in the red and blue zones (on the whole image) and mark them accordingly. It is helpful
when you need to cut out inscriptions or a lattice.

Mask Smoothing. This parameter is used to soften the edges of the cutout object. The higher
the value, the more smooth and blurry the edges are.

Sharpen Edges. This parameter changes the hardness of the edges of the cutout image. The
higher the value of this parameter, the sharper the edges are.

Sensitivity. This parameter influences the amount of details revealed in difficult areas. The
higher the value of this parameter, the more semi-transparent details are visible.
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Step 5. Click on  to re-process the image with the new settings.

 

Result on a color background

 

If you wish you can edit the mask in Manual mode.

Note: If you want to work in both modes and with all tools, use the modes sequentially: first Auto,
then Manual. If you switch to the automatic mode and run the image processing again, the result of
using the smart brushes will be lost.
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MANUAL SELECTION TOOLS

The Manual mode contains the set of the smart brushes to make a selection, and the post-processing
tools to edit the result.

Selection Tools:

The Quick Selection  tool selects an object by analyzing colors of neighboring pixels. Draw with

this brush over the image, and the selection expands, automatically finding edges and filling areas.
Read more.

 

 

The standard selection tools , , ,  are intended for creating geometric shapes and

freeform selections. Read more.
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The Magic Brush  lets selecting complex objects and is also helpful to improve the result

achieved with the automatic selection tools. This intelligent brush works with color sets: it keeps
some colors and deletes others. Read more.

Post-Processing Tools:

You can also use these post-processing tools: Blur Brush , Background Eraser ,

Desaturation Brush , and History Brush .

 

AKVIS SmartMask

51



QUICK SELECTION

The Quick Selection tool  selects an object by analyzing colors of neighboring pixels. Draw with this

brush over the image, and the selection expands, automatically finding edges and filling areas.

 

Original Image

Step 1. Choose a mode to make a selection: New, Add, or Subtract.

New . In this mode a new selection will be created. If there are selected areas on the

image, they will be deselected. Once you draw with the brush, the mode will automatically
switch to Add.

Add . The selection area will be increased by adding new fragments.

Subtract . You can remove the areas of the selection you don't want by activating this

mode.

Step 2. Adjust the tool's parameters:

Size. It's the diameter of the brush.

All similar colors will be selected, considering the edges of the objects and the value of the
Tolerance parameter.

Tolerance. When the value of this parameter is increased, more colors are included in the
selected area. If it is set to 0 the brush selects only the areas where it's applied.

 

Tolerance = 5

 

Tolerance = 50
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Step 3. Make a new selection drawing with the brush over the image.

Step 4. Click on  and choose a command (what you want to do with the selection): 

Remove Selected Areas, Remove Unselected Areas, Invert Selection, or Deselect.

For example, use the second command to remove the background:

 

Result

You can use the Magic Brush  and other tools to edit the selection.
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STANDARD SELECTION TOOLS

The standard selection tools in SmartMask are intended for creating geometric shapes and freeform
selections. The selected area is marked by a dotted outline. You can move the selection outline in the

image by placing the cursor  inside the selected area and dragging it.

 

Selection

 

Selections Tools:

Rectangular Selection  lets selecting rectangular and square areas. Drag over the area you want

to select with the left mouse button.
Elliptical Selection  lets selecting elliptical or circular areas.

Lasso  allows creating freehand selections. Draw a selection line around an object. When you

release the left mouse button, the contour will be closed, the final point will be connected to the
start one.
Polygonal Lasso  lets creating a freehand selection from straight segments. Move the cursor and

left-click on each point, the program will automatically draw a straight line between two points. To
close the contour bring the cursor to the first point or make a double-click in the final point.

Hold Shift  to make a square or a circle and to draw a perfectly vertical/horizontal line.
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The tools options will be shown in the Settings Panel and in a floating box when right-clicking on the image:

Selection Mode defines the result of the interaction of selections:
New . When creating a new selection, the previous selection disappears.

Add . The selection area will be increased by adding new fragments.

Subtract . This mode lets removing the part of the selection.

Intersect . This mode lets keeping only the intersection area of the selections.

Feather (0-250). The parameter lets blurring edges of the selection.

Anti-aliasing. The check-box lets smoothing the jagged edges of the selection. Enable this option
before creating a selection!

 

Add

 

Subtract

 

Feather = 0

 

Feather = 10

 

Anti-aliasing is disabled

 

Anti-aliasing is enabled

AKVIS SmartMask

55



From Center. The check-box lets creating a selection (a rectangle or an ellipse) using a start point,
where the cursor is, as a center. Otherwise, selections are created from a corner.
Style. You can specify a size of a selection:

Normal. The size of a selection is determined by dragging the cursor.
Fixed Size. This option lets you create a selection with exact dimensions (height and width, in
pixels).
Fixed Ratio. The ratio of height and width of a selection remains fixed.

Click on  and choose a command (what you want to do with the selection): 

Remove Selected Areas, Remove Unselected Areas, Invert Selection, or Deselect.

You can use the Magic Brush  and other tools to edit the selection.
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MAGIC BRUSH

The Magic Brush tool  lets you select complex objects and is also helpful to improve the result

achieved with the automatic selection tools. This intelligent brush works with color sets: it keeps some
colors and deletes others.

The Magic Brush keeps the points having the colors listed in the Keep Colors field and deletes the points
having the colors listed in the Drop Colors field. Other colors are kept or deleted according to their
closeness to one or another color set.

 
Original Image

Step 1. Select colors for the fields: Keep Colors and Drop Colors using the eyedroppers  under

each list in the Settings Panel. You can select a maximum of 5 colors in a list.

Click on the eyedropper's icon to activate the tool (Keep Color Picker or Drop Color Picker), then
click on a point on the image.

When you click on the image with the eyedropper, it displays a Color Ring with 5 sectors that shows
the information about the colors in this area:
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1. Gradient line with the current color in the center, on the left side is +30% black, and on the
right side +30% white.

2. The previously selected color.

3. The current color of the pixel where the cursor is.

4. Colors of surrounding pixels.

5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px (around the
eyedropper's tip).

This smart tool helps you select colors more precisely. If it's hard to catch a certain color, you can
see adjacent tints in the Color Ring and select the color on the ring while holding the Ctrl -key.

The check marks in the Keep/Drop lists define the colors that will be taken into consideration when
calculating the result. To exclude a color from processing just uncheck it.

In the Keep Colors field, you can configure the following settings for each color:

Transition (10-100). The parameter defines the smoothness of the boundary between the
given color and the background that should be deleted. The smaller the value of the parameter,
the rougher the processed boundary will be.

Priority (10-100). Colors with a higher priority will remain in the image after processing with
the brush. The lower the priority, the higher the probability that the color will be removed.

Activate the Enable Priority check-box in order for the specified values for the Transition and
Priority parameters to be taken into account when processing.

Lab Colors check-box. When the check- box is activated, the brush uses the Lab color space, which
can improve the accuracy of the processing result. When the check-box is disabled, the brush uses
the RGB color space.

To delete a color from the list, select this color with a left-click of the mouse and click on . You

 

Check-Box Disabled

 

Check-Box Enabled

 

Check-Box Disabled

 

Check-Box Enabled
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can select several colors with the Ctrl -key. It's possible to clear the list using the menu that shows

by right clicking on the list.

You can save the lists of the colors by using  and load by clicking on .

Step 2. Adjust the diameter and hardness of the brush:

Size is the tool's diameter (in pixels).

Hardness is the blurriness of the tool's edges. The lower the value the more blurry the tool's
edges become.

Step 3. Choose the operation mode for the tool:

Drop . In this mode the Magic Brush deletes only the points having the same colors as

listed in the Drop Colors field.

Keep . In this mode the Magic Brush restores only the points having the same colors as

listed in the Keep Colors field.

Keep & Drop . When this mode is enabled, the Magic Brush removes the points having

the same colors as those listed in the Drop Colors field and colors close to them, and it
restores the points having the same colors as those listed in the Keep Colors field and colors
close to them.

 

Hardness = 50

 

Hardness = 100
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Step 4. You can also adjust the parameters of the brush in the Brush Sensitivity group:

Keep Colors. The higher the value of this parameter, the wider the range of the colors kept on
the image.

Drop Colors. The higher the value of this parameter, the wider the range of deleted colors.

General Sensitivity. This parameter influences the amount of details recovered in difficult
zones. The higher the value of this parameter, the more semitransparent details are visible.

Note. When the Enable Priority check-box is selected, the value of the Drop Colors
parameter is ignored. 
If the value of the Transition parameter is less than the value of the Keep Colors
parameter + 10, the Transition value is ignored and the Keep Colors value + 10 is used.

Step 5. If you need to change a color shade of the object activate the Foreground Recovery
check-box.

In most cases the objects on a photo are not evenly lighted, therefore the cutout object can have
shades and colors reflected from nearby objects. Such color shades can be absolutely inappropriate
on a new background: for example, hair having a blue cast from the sky or a green shade from the
trees, shadows of objects on clothes...

Foreground Recovery helps to get rid of these unwanted color shades. Just select a color with a
click on the color plate. One click activates the eyedropper tool to pick a color from the image.
Double click opens the Select Color dialog. If you set Transparency (with a right click on the
plate), the brush will use the colors from the Keep Colors list.

The Strength parameter defines the influence of the applied color. The higher the value of the
parameter, the more the colors are subject to change.

 

Before application of the tool

 

Using Drop mode

 

Using Keep mode

 

Using Keep & Drop mode
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Apply the Magic Brush on the area you want to change, and the colors will get the chosen shade.

Step 6. Process the fragment you need using the Magic Brush tool.

 

Using Magic Brush

 

Without Foreground Recovery

 

Using Foreground Recovery
green color selected
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After you have adjusted the color sets and the parameters, draw over all areas you want to process.

 

Result on the white background

You can also use the post-processing tools to edit the result.
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CHROMA KEY

Chroma Key is a technique used in film and TV production to combine multiple images or frames into a
single composition. During the filming, the foreground object is placed in front of a monochromatic backdrop
(usually green or blue). In the post production, the color background is removed and replaced with an
alternative footage.

The Chroma Key mode  in AKVIS SmartMask allows you to quickly and accurately remove a

monochrome background.

Note: The feature is available only in Home Deluxe and Business licenses.

Attention! The chroma key should always be applied to the original image, so use this mode at the
first processing stage. Otherwise, the previous changes will be lost.

 

To remove the background from an image, adjust the following parameters:

Color. Using three color plates select the colors to remove. Click on a plate to activate the
eyedropper tool and sample a color from the image. Double-click on a plate to call the color selection
dialog. Right-click on a color plate to clear it.
Background. Select a type of your image's background. Depending on the chosen option, the
program will use different pixel removing methods. You can choose between three options:

Uniform. The background pixels will be removed by the difference between their colors and
luminance levels. Use this option for removing monochrome backgrounds as in blue screen or
green screen images. Note that this method preserves more details than other methods.

Non-Uniform. The background pixels will be removed only by the difference between their
colors. Use this option for images with an uneven background.

Gradient. This option uses a complex approach and is intended for removing gradient
backgrounds.

 
Removing Background
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Drop Colors/Keep Colors (0-100). The parameter determines the range of colors that should be
deleted.

The higher the Drop Colors value, the more shades of the specified color will be removed from the
image. The higher the Keep Colors value, the more shades of the specified color remain in the
image. The range between these two parameters determines the number of pixels that become
translucent.

Edges Recovery (0-100). The parameter replaces the colors of semi-transparent pixels on the
fragment's edges with the colors of neighboring opaque pixels.

Uniform Background Non-Uniform Background Gradient Background

 

Drop Colors = 5, Keep Colors = 20

 

Drop Colors = 25, Keep Colors = 50

 

Edges Recovery = 10

 

Edges Recovery = 100
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Desaturation (0-100). The parameter reduces the color saturation of semi-transparent pixels on the
edges of the cut-out fragment.

Blur (0-100). The parameter blurs the fragment's edges.

In the View Mode drop-down menu, you can select an option for displaying the cut-out object in the
Image Window.

To accept the changes, press the OK button. To exit the mode without saving changes, click the Cancel
button. To restore the default settings, click on Default.

 

To edit edges of the resulting fragment use the Refine Edges mode.

To replace the old background with a new one, use the Custom Background mode.

 

 

Desaturation = 0

 

Desaturation = 100

 

Blur = 1

 

Blur = 5
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REFINE EDGES

The Refine Edges feature  (available for Deluxe and Business licenses) is extremely helpful for quick

editing edges of selections or cutout objects.

 

Using tools and parameters in the Settings Panel, adjust the edges of the selection area.

Specify the type of an area to change. Choose Selection to change the selection outline, or Cutout to
tweak the edges of the extracted object.

In the Preview pop-up menu, select how the selection/cutout will be displayed in the Image Window when
editing.

 

The Refine Radius  tool allows you to more accurately define the refinement area. Use the Eraser tool

 to edit the selection.

Size (1-1000). The maximum width of a line made by the brush (in pixels).

Show Selection check-box. If the check-box is enabled, the selection is always displayed. If it is
disabled, the selection is displayed only when editing and remains hidden for the rest of the time.

Refine Edges
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Adjust the edges using the following parameters:

Radius (0-250). The parameter specifies the width of the area around the selection/cutout, where
the edge refinement is applied.

Initial Cutout Processing Result

 

Radius = 50

 

Radius = 200
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Threshold (-10..80). The parameter specifies the brightness/color range of pixels that will be deleted
when increasing the parameter.

Transition (0-100). The parameter increases the smoothness of the transition within the specified
area.

Note. The Threshold and Transition parameters affect the image only if the value of the
Radius parameter is not zero or the Refine Radius tool was used.

The Radius parameter and the Refine Radius tool work in a similar way, with the main
difference being that the parameter sets the same width for the area along the entire edge,
and the tool allows you to change the size of the area in different parts of the border.

Feather (0-100). The parameter softens the transition between the selection/object and the
surrounding background creating a semi-transparent area.

 

Threshold = 0

 

Threshold = 50

 

Transition = 20

 

Transition = 90
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Contrast (0-100). The parameter sharpens the edges of the selection or the cutout object.

Shift (-100..100). The parameter reduces or enlarges the selection/object within the transition area
changing the transparency of the semi-transparent pixels.

Desaturation (0-100) (only for Cutout). The parameter decreases the color saturation of the semi-
transparent pixels on the edges of the extracted object.

 

Feather = 2

 

Feather = 20

 

Contrast = 5

 

Contrast = 50

 

Shift = -50

 

Shift = 50

AKVIS SmartMask

69



Press OK to apply changes, or Cancel to close the options.

Click the Reset button to discard all changes made in this mode and set the parameters to the default
values.

 

 

Desaturation = 0

 

Desaturation = 50
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POST-PROCESSING TOOLS

There are the tools to make final touches and correct the result: Blur Brush , Background Eraser 

, Desaturation Brush , and History Brush .

They are accessible on the Toolbar in the Manual Mode.

Blur Brush . This tool creates a blur effect by reducing the color contrast between adjacent

pixels.

The brush is adjusted with the Strength parameter. The higher the value of the parameter, the
stronger the effect is.

Background Eraser . This tool erases the areas to which it is applied.

Strength (1-100). The amount of influence on an image. As this parameter's value is
increased, the degree of transparency left by the brush increases.

The Tolerance check-box lets you control the range of the colors to remove. By default the
check-box is disabled, and the tool removes all colors.

When it's enabled, the tool samples the color in the center of the brush at the moment of the
click. Draw with this tool over the image, and the selected color will be erased.

The lower the value of the Tolerance parameter, the less colors are used. When the value of
this parameter is increased, more colors are erased.

 

Before Using the Blur tool

 

After Using the Blur tool

 

Using Background Eraser: Tolerance Off

 

Using Background Eraser: Tolerance On
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Desaturation Brush . The tool reduces the color saturation in the image area being processed.

Strength (1-100). The parameter controls the intensity of the desaturation. The higher the
value of the parameter, the weaker the saturation of the pixels becomes.

History Brush . This tool restores the area to its original state.

Strength (1-100). The degree of restoration to the original state. At lower values there will be
less restoration and more blending with the effect; at values near 100% the original condition
will be restored more completely.

 

You can adjust the parameters for these tools:

Size. The maximum width of a line drawn with the brush.

Hardness. The degree of blurriness of the brush's edges. As the value of this parameter is
increased the brush's edges become harder. At lower values the transition between these areas
is smoother.

 

 

Before Using the Desaturation Brush

 

After Using the Desaturation Brush

 

Before Using the History Brush

 

After Using the History Brush
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ADDITIONAL TOOLS

The program also has additional tools which will make your work simplier.

They are available in both Auto and Manual modes.

The Hand tool  is designed to scroll the displayed area of the image in the window if the whole

image doesn't fit into the window at the chosen scale. To move the image you should press this
button, put the cursor onto the image, press the left button and, keeping it pressed, move the image
in the window.

To scroll the image in the Image Window you can also press the spacebar on the keyboard and drag
the image with the left mouse button. 
Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

 

Scrolling of displayed area with Hand Tool

The Zoom tool  is designed to change the image scale.

To zoom in left click on the image. To zoom out left click with Alt  on the image. You can use

hotkeys to change the image scale. 
It is also possible to increase the scale of the selected area. For this purpose press  and select a

rectangular area on the image. When the rectangular area is selected, the image scale will be
changed so that the selected part of the image will fill the whole window. 
Double-clicking on the tool's icon  on the Toolbar makes the image scale to 100% (actual size).

 

Increasing scale of the selected area with Zoom Tool
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SEPARATE A PERSON FROM A PHOTO

AKVIS SmartMask lets you select objects on images and remove backgrounds.

We've tried to use both modes and as many tools as possible to get you acquainted with the program. 
The procedure took 10 minutes.

The original image

Different background images. 
Click to open in a larger window.

This example has been created in AliveColors, but you can use any other photo editor compatible with
AKVIS SmartMask plugin. Alternatively, you can use the standalone version of SmartMask.

Step 1. Open an image in your photo editor.
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Step 2. Copy the image to a new layer (Layers -> Duplicate).
Step 3. Call AKVIS SmartMask plugin. For this purpose select the command Effects -> AKVIS ->
SmartMask.

By default the plugin uses the Auto mode.

Step 4. Use the Keep Area Pencil  to draw an outline within the girl's figure.
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Use the Drop Area Pencil  to outline the background.

Step 5. Press the button  to start processing the image.

The program will take into consideration the drawn outlines and generate two zone types: the area
marked with the red pencil will be deleted (the points in this area have Transparency = 100%), the
areas marked blue will be kept (the points in this area have Transparency = 0%).
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The clothes have been cut out very well, but in general the result does not fully satisfies us. We
continue our work.

Step 6. Choose the Transition Area Pencil , increase its size, and draw over the complex areas

(the hair).

Step 7. Click on  to start processing the image again.
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The result is much better indeed. Now we have to remove the stains on the background.

Step 8. Switch to the Manual mode. Here we can improve the result.
Step 9. Use the Zoom  tool to scale up the image and work with the problem areas.

Step 10. Switch to the workspace mode that shows the original image and the result in two windows
side by side.

Activate the Magic Brush  and use the eyedropper tools  to pick up the colors for the Keep

Colors and Drop Colors lists. Choose the color of the hair for the Keep Colors list and the color of
the wall behind the girl for the Drop Colors list.
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Step 11. The Keep & Drop mode is enabled.

In this mode, the Magic Brush  removes the points having the same colors as those listed in the

Drop Colors field and colors close to them, and restores the points having the same colors as those
listed in the Keep Colors field and colors close to them.

Draw over the hair using the Magic Brush tool.

Here is the result:

AKVIS SmartMask

79



Step 12. We can improve the result further.

Increase the value of the Sensitivity parameter of the brush and draw again over the hair.

Step 13. Now enable the Foreground Recovery check-box and choose the umber color.

Use the Magic Brush again. Now the hair looks natural!
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Step 14. Press the button  to apply the result.

Now you can add any background and enjoy the result.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a
special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish
colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains
many templates and texture samples that can be used to create a virtually limitless variety of options for
generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil
Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to
create a piece of art out of any picture! More…
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AKVIS Chameleon — Photo Collage Creation

(Windows | Mac)

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and
entertaining. The tool is very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…

 

AKVIS Charcoal — Charcoal & Chalk Drawings

(Windows | Mac)

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the
program you can make professional-looking expressive black and white images. Playing with colors and
options you can achieve outstanding artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

(Windows | Mac)

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. Just indicate the
desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object's
border and tailors the new color to the grayscale tones of the initial picture. More…
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AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a
texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely
natural and makes you see things differently. Recoloring is also made easy. More…

 

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking
line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures!
More…
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AKVIS Enhancer — Bring Detail To Your Pictures

(Windows | Mac)

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and
mid tone areas of a photo with uneven exposure. Enhancer improves every part of the image! The software
works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to
fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones.
More…

 

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

AKVIS Frames is free software designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single
photo. The program can also be used for photo correction. The program brings life and color to your
photos! More…
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AKVIS LightShop — Light and Star Effects

(Windows | Mac)

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers
advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention
and brighten up any photo. Add a little magic to your pictures! More…

 

AKVIS Magnifier — Change Image Size without Quality Loss

(Windows | Mac)

AKVIS Magnifier helps to resize images without loss in quality. Whether creating poster-size images,
adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look
sharper and better defined. More…
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AKVIS MakeUp — Retouch Your Portrait Photos!

(Windows | Mac)

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial
imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your
pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos

(Windows | Mac)

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos.
The program includes a number of effects: Rain
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AKVIS Neon — Glowing Drawings from Photos

(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon
image that looks like drawn with luminescent ink. More…

 

AKVIS Noise Buster — Digital Noise Reduction

(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be
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seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program
is efficient against both color and luminance noise. More…

 

AKVIS OilPaint — Oil Painting Effect

(Windows | Mac)

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right
before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this
cutting-edge software you can become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

(Windows | Mac)

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike
digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash
your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

(Windows | Mac)

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic
techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist
manner. Discover the world of bright colors! More…

 

AKVIS Refocus — Focus Improvement & Blur Effects

(Windows | Mac)

AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo or
bring into focus only the selected part to make the subject stand out against the background. It's also
possible to add bokeh and lens blur effects to your photos. 
The software works in five modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…
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AKVIS Retoucher — Image Restoration Software

(Windows | Mac)

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software
removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently
reconstructs the missing parts of the photo using the information of the surrounding areas. More…

 

AKVIS Sketch — Convert a Photo to a Pencil Sketch

(Windows | Mac)

AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings. 
Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of
art is good taste and AKVIS Sketch. More…

AKVIS SmartMask

92

http://akvis.com/en/refocus/index.php?ref=help
http://akvis.com/en/retoucher/index.php?ref=help
http://akvis.com/en/retoucher/index.php?ref=help
http://akvis.com/en/retoucher/index.php?ref=help
http://akvis.com/en/sketch/index.php?ref=help
http://akvis.com/en/sketch/index.php?ref=help


 

AKVIS SmartMask — Save Time on Complex Selections!

(Windows | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never
been so simple! The software considerably increases your productivity. You will be freed from boring work
and will have more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software
turns ordinary images into amazingly realistic aquarelle pieces of art. More…
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